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Introduction 

Welcome to Virtual Column 2, the simulation software for Ion Chromatographic 

retention modelling and optimisation. Virtual Column 2 is a powerful application that 

uses previously acquired (embedded) retention data to simulate all possible 

chromatograms in a defined search area. Virtual Column 2 determines the optimal 

eluent composition using a choice of two resolution criteria, Minimum Resolution or 

Normalised Resolution Product. 

Virtual Column 2 is designed with the needs of a range of users in mind. It is intended 

for practical method development, educational and training purposes, refinement of 

existing methods and exploratory investigations including information gathering and 

experimental design overview. 

Virtual Column 2 uses the most advanced retention prediction models available today 

to achieve accurate prediction of chromatograms. Embedded data, which have been 

acquired using a correct experimental design, are used to solve these models. 

Virtual Column 2 uses these retention prediction algorithms to predict retention data 

across the entire search area. Virtual Column 2 ranks these virtual chromatograms 

according to two criteria, the Minimum Resolution or Normalised Resolution Product. 

A value of zero indicates that at least one peak pair is co-eluting. For the Minimum 

Resolution criterion, a value of 1.5 is generally regarded as baseline separation, 

although a value of 1.2 is often considered acceptable resolution for most 

applications. For the Normalised Resolution Product, a value of one indicates that all 

peaks are evenly spaced across the chromatogram. 

Detailed information about the Retention Models and Resolution Algorithms can be 

found in Appendix A. 

Virtual Column 2 has two options for finding the optimum eluent conditions, 

separation or time. A global optimum is defined as the chromatogram with a 

maximum value for the selected resolution criterion. Virtual Column 2 can also find 

the fastest chromatogram for which the value of the resolution criterion does not fall 

below a specified value. This capability is designed to optimise the speed of a 

separation, rather than the resolution of peaks. 
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Virtual Column 2 allows the user to customise a simulation or optimisation to match 

their own system through the adjustment of several key parameters including column, 

eluent and analyte selection, peak areas, peak shapes (asymmetry), void time and 

column efficiency (number of theoretical plates). Virtually any system can be 

simulated through the adjustment of these parameters. 

Getting Started contains the following parts: 

• Chapter 1, “Installing Virtual Column 2,” contains information on installation 

procedures, system requirements, starting, uninstalling and upgrading Virtual 

Column 2. 

• Chapter 2, “Learning Virtual Column 2. Tutorial 1 – The Wizard,” introduces 

the Virtual Column 2 wizard. 

• Chapter 3, “Learning Virtual Column 2. Tutorial 2 – Dual Species Eluent 

Optimisation,” introduces the main interface for Virtual Column 2 and guides 

the user through the features of Virtual Column 2 that apply to dual species 

eluent systems, in particular, carbonate eluents. 

• Chapter 4, “Learning Virtual Column 2. Tutorial 3 – Single Species Eluent 

Optimisation,” introduces the main interface for Virtual Column 2 and guides 

the user through the features of Virtual Column 2 that apply to single species 

eluent system, in particular, hydroxide eluents. 

• Chapter 5, “Glossary,” explains some of the terms using in this manual. 

• Appendix A, “Retention Models and Resolution Algorithms,” gives detailed 

information about the models and algorithms used in Virtual Column 2.
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Chapter 1 

Installing Virtual Column 2 

1.1. Introduction 

This chapter contains information on the following: 

• system and software requirements. 

• installation instructions. 

• starting Virtual Column 2. 

• uninstallation instructions. 

1.2. System Requirements 

Operating System Software 

Virtual Column 2 is a 32 bit Windows# application. To run Virtual Column 2 you 

must have a 32 bit version of Windows such as Windows 95, 98, Me, NT 4.0 or 2000. 

Virtual Column 2 will not run on earlier versions of Windows such as Windows 3.1, 

3.11, NT 3.5 or NT 3.51. 

Computer Hardware 

Virtual Column 2 is compatible with Intel∗  Pentium® class processors or higher, 

including Pentium Pro, Pentium II, Pentium III, AMD† K6, Athlon®, Duron® and 

compatible processors. 

Math Coprocessor 

Virtual Column 2 is very floating point intensive and is therefore incompatible with 

processors that do not have a math coprocessor such as 386 and 486 SX processors. 

                                                 

# Windows is a registered trademark of the Microsoft Corporation 

∗  Intel is a registered trademark of the Intel Corporation 

† AMD is a registered trademark of Advanced Micro Devices 
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Memory 

Virtual Column 2 is compatible with any memory size that runs your version of 

Windows. However for acceptable performance we recommend at least 32 MB of 

RAM for Windows 95 or Windows 98 and 64 MB of RAM for other Windows 

versions. For large numbers of analytes more memory may be required for acceptable 

performance. 

Hard Drive Storage 

Virtual Column 2 consumes less than 10 MB of hard drive space. 

Display 

Virtual Column 2 requires a minimum resolution of 800 x 600 and 256 colour depth. 

However we strongly recommend a display capable of 1024 x 768 or higher 

resolution and at least 16-bit colour. 

Printer 

Virtual Column 2 can print to any Windows compatible colour or black and white 

printer. 

1.2. Installing Virtual Column 2 

The Virtual Column 2 installation program will decompress files and install them to 

the correct directories on your computer hard drive. The Virtual Column 2 installation 

program will also set up shortcuts in your start menu. In order to install Virtual 

Column 2 it is necessary to locate the Setup program located in the Virtual Column 2 

directory: 

 

If Virtual Column 2 came on a CD-ROM, then the Virtual Column 2 directory should 

be located on your CD-ROM drive (typically D drive). If you downloaded Virtual 

Column 2 as a zip file, then it will be necessary to decompress the Virtual Column 2 

directory to your hard drive. A utility such as WinZip# should automate this 

                                                 

# WinZip is a trademark of WinZip Computing. 
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procedure. Once the zip file is decompressed to your hard drive, locate the Virtual 

Column 2 directory. 

• Double left click on the Setup icon. 

• Follow the on-screen instructions to set up Virtual Column 2 on your system. 

1.3. Starting Virtual Column 2 

The following is only applicable if Virtual Column 2 has been installed correctly on 

your system. 

• Position the mouse over the Start button of your task bar and left click on 

“Start”. 

• Position the mouse cursor over “Programs” and either left click or wait for the 

programs menu to open. 

• Position the mouse over “Virtual Column 2” and either left click or wait for 

the Virtual Column 2 menu to open. 

• Left click on “Virtual Column 2” to start the application. 

1.4. Uninstalling Virtual Column 2 

The following is only applicable if Virtual Column 2 has been installed correctly on 

your system. Some minor variations may be noted with different versions of 

Windows. Please contact your computer support staff if the following does not apply 

to your system. 

• Open the Control Panels by either navigating to the “Settings” menu of the 

Start menu, or by opening the “My Computer” window and opening Control 

Panels. 

• Open the “Add/Remove Programs” control panel to show a list of all 

applications currently installed on your computer. Highlight “Virtual Column 

2” and click on “Change/Remove”. 

• Follow the on screen instructions to remove Virtual Column 2 from your 

system. It is usually safe to remove all files from your system, but if in doubt, 

contact your local administrator or IT support staff. 



 7

1.5. Upgrading Virtual Column 2 to a newer version 

If you have an older version of Virtual Column 2 on your system and want to upgrade 

to the latest version, it is recommended to uninstall the previous version before 

proceeding. Follow the uninstallation procedure in section 1.4, and then install the 

new version according to the procedure in 1.2. 
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Chapter 2 

Learning Virtual Column 2. Tutorial 1 – The 
Wizard 

2.1. Introduction 

In order to run, Virtual Column 2 requires detailed information about the system it is 

trying to model. The Virtual Column 2 Wizard is the part of the application designed 

to gather this information in as simple a manner as possible. This chapter will be 

divided into three main sections. 

“Getting Started” will outline the procedure of starting Virtual Column 2, the layout 

of the wizard and the files used by the Virtual Column 2 for storing column 

information (the Column Database) and user selection files. 

“Using the Wizard” takes you through the procedure of using the wizard interface and 

setting up a simulation or optimisation. This tutorial will prepare you for Tutorial 2. 

“Using the Wizard selection files” introduces you to the concept of selection files, 

which speed up the process of using the Wizard. 

2.2. Getting Started 

Virtual Column 2 can be started using Windows’ Start menu. You can navigate to the 

Virtual Column 2 short cut and start the application by clicking on “Start”, 

“Programs”, “Virtual Column 2” and then left clicking the Virtual Column 2 

application short cut. 

When the program starts, a blank main window and the Virtual Column 2 Wizard 

window are created, which is shown in Figure 1. 
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Figure 1. Virtual Column 2 Wizard window. The list of mobile / stationary phase combinations 

may vary. 

Parts of the Wizard Window: 

Title Bar – Use the title bar to move the window by placing the mouse cursor over 

the bar, click and hold the left mouse button then move the window to the desired 

position and release the mouse button when finished. 

Instruction Text – The instruction text gives information on what step the Wizard 

is at, as well as instructions for the current step. 

Mobile / Stationary Phase List – The mobile / stationary phase list details all 

available databases currently installed. 

Load / Save Selection Button – The load / save selection button allows a 

selection to be loaded at step 2 of the Wizard and a selection to be saved at step 5 of 

the Wizard. During other steps the button is ‘greyed out’ and unavailable. 

Back Button – The back button is used to move a step backwards in the wizard. 

title bar

mobile / stationary 
phase list 

load / save

selection button

back button next button cancel button 

instruction text 
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Next Button – The next button is used to move a step forward in the wizard. 

Cancel Button – The cancel button is used to close the wizard and return to the 

main application window. 

2.3. Using the Wizard 

There are five steps in the Virtual Column 2 Wizard. 

Step One: Please select a mobile / stationary phase combination. 

After the program has been started, the wizard should be open at step one. 

• Left click once on “Carbonate : Bicarbonate on a Dionex AS14A 3mm 

column” so that the selection is highlighted. 

• Left click once on the Next button. The Wizard should advance to Step 2. 

Each available column database in Virtual Column 2 is given an entry in this list. The 

selection of the database will directly affect how Virtual Column 2 calculates 

retention data. In this case Virtual Column 2 will simulate a Dionex AS14A 3mm 

column with a carbonate : bicarbonate dual species eluent. 

Step Two: Please select the analytes you wish to include. 

After loading the column database in step one, Virtual Column 2 will list all analytes 

available in the loaded database (Figure 1). The available analytes will vary from 

database to database. 

• Left click once in the square check box to select each of the following 

analytes.  

o Void Dip, Fluoride, Chloride, Nitrite, Bromide, Nitrate, Chlorate, 

Iodide, Thiocyanate, Sulfate, Molybdate, Phthalate and Phosphate. 

o Use the scroll bar on the right to access analytes below the bottom of 

the wizard window. 

• Left click once on the Next button. The Wizard should advance to Step 3. 
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Figure 2. Virtual Column 2 Wizard Step Two. 

Step Three: Please enter your peak areas. 

For each selected analyte, Virtual Column 2 will list the default peak area and give 

you the opportunity to change it in a table (Figure 3). Typical values for peak areas 

are included in the column database to produce an acceptable looking virtual 

chromatogram. These values can be changed to reflect the actual peak areas of your 

system. For now we’ll leave the values as they are, except the void peak, which we 

will set to 0.1. 

• Left click once on the Peak Area cell for “Void Dip”. The value should 

become highlighted. 

• Press the delete button to remove the existing value. 

• Enter 0.1 and press the enter key. 

• Left click on the Next button. The Wizard should advance to Step 4. 
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Figure 3. Virtual Column 2 Wizard Step Three. 

Step Four: Confirm peak asymmetry values. 

For each selected analyte, Virtual Column 2 will list the default asymmetry value and 

give you the opportunity to change it (Figure 4). Accurate values for asymmetry are 

included in the column database. Because the databases were produced with new 

columns, changes in asymmetry due to column aging and degradation have not been 

taken into consideration. If the peak asymmetry values in your column differ from the 

embedded values, this step offers the opportunity to correct for any variations. 

• Left click once on the Asymmetry cell for “Void Dip”. The value should 

become highlighted. 

• Press the delete button to remove the existing value. 

• Enter 2 and press the enter key. 

• Left click on the Next button. The Wizard should advance to Step 5. 
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Figure 4. Virtual Column 2 Wizard Step Four. 

Step Five: Please enter the void time, number of theoretical plates 

and select a resolution criterion. 

Step five finishes the Wizard and gives you the chance to change the default void 

time, number of theoretical plates and select a resolution criterion (Figure 5). The 

embedded value for the void time is based on the system used to gather the embedded 

data. Because flow rates and configurations vary, void times also vary from system to 

system. By matching the void time of your system Virtual Column 2 can model your 

system more accurately. 

The default value for the number of theoretical plates is based on the sulfate peak of a 

new column. Changes in the number of theoretical plates due to column aging and 

degradation have not been taken into consideration. If the number of theoretical plates 

of your column differs from the default value, this step offers the opportunity to 

correct for any variations. 

• Double left click on the Void Time text box. The value should become 

highlighted. 

• Press the delete button to remove the existing value. 

• Enter 1.25. 
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Figure 5. Virtual Column 2 Wizard Step Five. 

• Double click on the Theoretical Plates text box. The value should become 

highlighted. 

• Press the delete button to remove the existing value. 

• Enter 6000. 

• If the ‘Minimum Resolution Criterion’ radio button is not selected, click on 

the circle next to it to select it. 

• Click on the finish button. The Wizard should close and the Virtual Column 2 

main window should become active. 

This step concludes the “Using the Wizard” tutorial. The “Using the Wizard selection 

files” tutorial will teach you how selection files can save you time when repeating 

similar optimisations and simulations. Tutorial 2 will teach you how to use the main 

interface of Virtual Column 2 and assumes you have just completed this tutorial. 

2.4. Using the Wizard selection files 

The Wizard selection files speed up the process of running the wizard when similar 

simulations and optimisation have to be repeated. Wizard selection files can be saved 

in step 5 of the Wizard and loaded in step 2. The selection file stores the analytes that 
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were selected using the Wizard, as well as the peak areas, asymmetry values and the 

void time (the number of theoretical plates, however, is not saved in the selection 

file). The chosen database is not stored in the selection file, so a single selection file 

can be applied to multiple databases. As databases vary on which analytes are 

available, any analytes chosen in a selection file that are unavailable in a database will 

be ignored. 

Follow Steps One through Four of the previous tutorial. 

Step Five: Please enter the void time of your system and select a 

resolution criterion. Save the modifications as a selection file. 

• Change the value of the Void Time to 1.25. 

• Left click the Save Selection button to bring up the Save As dialog box. 

• Enter a File Name for the selection file, taking note of the directory to which it 

is being saved by using the ‘Save in’ drop-down list box. 

• Left click the Save button to save the selection file to the hard drive. This 

should return you to Step Five of the Wizard. 

• Left click on Finish to close the Wizard. The Virtual Column 2 main window 

should become the active window. 

This procedure has saved the selection file to the hard drive. Rather than repeating 

steps two through five of the previous tutorial, it is now possible to open the selection 

file and skip steps two through five and obtain identical results. 

Opening your selection file. 

• Position the cursor over the word “File” on the main window’s menu bar and 

left click once. Position the cursor over the word “New” and left click once. 

This should restart the wizard. 

• Left click once on “Carbonate : Bicarbonate on a Dionex AS14A 3mm 

column” so that the selection is highlighted. 

• Left click once on the next button. The Wizard should advance to Step 2. 

• Left click once on the Load Selection button. This should open the Open 

dialog box. If the directory is different to the one used to save the file, navigate 
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to the correct directory by using the ‘Look in’ drop-down list box. Left click 

once on the File Name that you chose to save your selection file as to highlight 

it. It should have a .vcx file extension. 

• Left click once on the “Open” button. The Wizard should advance to step five 

with a void time value of 1.25 and 7000 Theoretical Plates. 

• Change the Theoretical Plates number to 6000. 

• Left click once on the “Finish” button. This should close the wizard and the 

Virtual Column 2 main window should become active. 

This procedure will produce the same results as the tutorial in Section 2.3. After 

opening a selection file it is possible to use the back button to return to a previous 

step, make a change, and then use the next button to return to the end of the wizard. 

Thus, small changes can be made without having to repeat the entire procedure of 

running the wizard. 

Tutorial 2 will teach you how to use the main interface of Virtual Column 2 and 

assumes you have just completed this or the previous tutorial. 
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Chapter 3 

Learning Virtual Column 2. Tutorial 2 – The Main 
Window (dual species eluents) 

3.1. Introduction 

In order to run, Virtual Column 2 requires detailed information about the system it is 

trying to model. The Virtual Column 2 Wizard is the part of the application designed 

to gather this information in as simple a manner as possible. This chapter assumes that 

the tutorial in Chapter 2 has been recently been completed. If not, restart the 

application and follow the steps in Chapter 2, section 2.3 “Using the Wizard”. 

3.2. Getting Started 

After completing the Wizard in the previous chapter, the application should look 

something like Figure 6. 

Parts of the Main Window: 

Control menu button – The control menu contains the commands to resize, 

move, maximise and close the Virtual Column 2 main window. 

Title bar - The title bar contains information about the name of the application 

window and can be used to move the window. 

Minimise button – The minimise button is used to minimise the application 

window to the task bar. The program will still be running but will take no space on the 

desktop. 

Maximise / restore button – The maximise button is used to maximise the 

application windows to use the entire desktop area. When the window is maximised 

the restore button is used to restore the window to its original size. 

Exit button – The exit button is used to close the application. 
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Figure 6. Virtual Column 2 main window for dual species eluents. 

Horizontal and vertical scroll bars – These scroll bars are used to adjust the 

eluent concentration and ratio respectively. They can be adjusted using the arrows to 

move one increment/decrement at a time, or by clicking on the scroll bar to adjust 10 

increments at a time. The scroll indicator can also be dragged using the left mouse 

button. 

Virtual chromatogram title – The title of the virtual chromatogram includes 

the eluent concentration, ratio and resolution criterion value. 

Unzoom button – This button is used to restore the chromatogram after zooming. 

Asymmetric Peaks check box – This check box is used to turn the asymmetric 

peaks function on and off. 

control-menu button title bar menu bar minimise button
maximise / restore button

exit 
button 

vertical scroll bar 

horizontal scroll bar

virtual chromatogram title

peak label 

unzoom button check boxes 

status bar

scroll indicator scroll indicator 
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Auto Scale X-Axis check box – This check box is used to turn the auto scale x-

axis function on and off. 

Peak labels – These labels are used to identify the analyte for each peak. 

3.3. Using Virtual Column 2 

The Virtual Column 2 main window is split into two sections, the Resolution 

Response Surface and the Virtual Chromatogram. The Resolution Response Surface is 

a contour map of the resolution criteria across the entire search area. Areas of blue are 

maxima (high resolution) and areas of red are minima (low resolution). 

The Virtual Chromatogram is a representation of the chromatogram that would be 

expected with the currently selected eluent conditions. The horizontal and vertical 

scroll bars can be used to select any eluent condition within the search area. The 

program starts by locating the global maximum and setting the initial eluent 

conditions to that value. 

Maximising the Virtual Column 2 Window 

• Left click once on the maximise / restore button. The window should enlarge 

to fill the entire screen. Virtual Column 2 may take a few seconds to 

recalculate and redisplay the contour plot. 

It is usually easier to work with a maximised window. 

Changing the eluent concentration and ratio 

Virtual Column 2 indicates the currently selected eluent conditions using a cross hair 

on the resolution response surface. If the selected eluent condition lies at the edge of 

the response surface, the cross hair may not be visible. 

• Position the cursor over the right arrow of the horizontal scroll bar. Press and 

hold the left mouse button. The eluent concentration should increment. Hold 

the left mouse button down until the eluent concentration is 10.08 mM and 

then release the mouse button. 

• Single left click the left or right arrows of the horizontal scroll bar to move one 

increment at a time. 

• The minimum resolution criterion should be 1.246. 
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• Position the cursor over the up arrow of the vertical scroll bar. Press and hold 

the left mouse button. The eluent ratio should increment. Hold the left mouse 

button down until the eluent ratio is 62.0 % and then release the mouse button. 

• Single click the up or down arrows of the vertical scroll bar to move one 

increment at a time. 

• The minimum resolution criterion should be 1.200. 

• Position the cursor over the horizontal scroll bar between the left arrow and 

the scroll indicator. Press the left mouse button once. The eluent concentration 

should decrement a larger value than with the left arrow. The eluent 

concentration should be 8.48 mM. 

• Position the cursor over the vertical scroll bar between the down arrow and the 

scroll indicator. Press the left mouse button once. The eluent ratio should 

decrement a larger value than with the down arrow. The new eluent ratio 

should be 58.0 %. 

• The minimum resolution criterion should be 1.247. 

• Position the cursor over the scroll indicator of the horizontal scroll bar. Press 

and hold the left mouse button. Move the cursor in a straight line to the left. 

The eluent concentration should decrease as the scroll indicator moves. When 

the eluent concentration reaches 5.60 mM release the left mouse button. 

• Position the cursor over the scroll indicator of the vertical scroll bar. Press and 

hold the left mouse button. Move the cursor in a straight line downwards. The 

eluent ratio should decrease as the scroll indicator moves. When the eluent 

ratio reaches 51.6 % release the left mouse button. 

The eluent concentration can also be modified by left clicking directly on the 

resolution response surface. 

• Position the cursor over the resolution response surface approximately at the 

7.5 mM and 80 % eluent conditions. Left click the mouse button once. The 

eluent conditions should change to approximately these values. 
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• Position the cursor over the ‘Criterion’ menu on the menu bar, left click once. 

A menu should appear. Position the cursor over the ‘Find Global Optimum’ 

menu, left click once. 

• You should now be back at the global optimum eluent composition and the 

minimum resolution criterion should be 1.316. 

Zooming and unzooming a part of the virtual chromatogram 

• Position the cursor so that it is to the left of the void dip but above the height 

of the chloride peak. Press and hold the left mouse button. Move the cursor 

downwards and to the right, a rectangular box should be created from where 

you pressed the left mouse button to wherever you move the cursor. Move the 

cursor to just below the base of the ‘Phosphate’ peak and release the left 

mouse button. 

 

Figure 7. A Virtual Chromatogram displaying the rectangular zoom box. 

• The seven peaks of fluoride, chloride, nitrite, bromide, nitrate, chlorate and 

phosphate should now occupy the entire virtual chromatogram. 

• Left click once on the unzoom button to return to the original virtual 

chromatogram. 

Alternatively, unzooming can also be achieved by left clicking and drawing any sized 

rectangle from the bottom right to the top left. 

Auto scaling the X-Axis 

• Left click once on the ‘Auto Scale X-Axis’ check box. The tick in the box 

should disappear and the virtual chromatogram should redraw itself with 96.2 
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minutes as the maximum on the time axis. The virtual chromatogram should 

no longer run to the end of the x-axis. 

• Left click and hold the left arrow of the horizontal scroll bar. The eluent 

concentration should decrement until the minimum of 4.0 mM is reached, then 

release the mouse button. 

• As the eluent concentration decremented, the virtual chromatogram should 

have been redrawn taking up more and more of the x-axis until all but the last 

few minutes of the x-axis is used. 

• Left click and hold the right arrow of the horizontal scroll bar. The eluent 

concentration should increment. Release the mouse button when the eluent 

concentration reaches 12.48 mM. The virtual chromatogram should now only 

take up about one third of the x-axis. 

• Left click once on the Auto Scale X-Axis check box. A tick should appear and 

the virtual chromatogram should redraw itself so that the chromatogram uses 

the entire x-axis. 

When Auto Scale is turned off the total time of the chromatogram is defined by the 

longest possible chromatogram for the entire search area. 

Finding the optimal and fastest eluent conditions 

• Position the cursor over the ‘Criterion’ menu on the menu bar, left click once. 

A menu should appear (Figure 8). Position the cursor over the ‘Find Fastest 

Chromatogram…’ menu, left click once. A ‘Fastest Chromatogram Finder’ 

dialog box should appear (Figure 9). 

 

Figure 8. Criterion menu. 
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Figure 9. Fastest Chromatogram Finder dialog box. 

• Enter a minimum acceptable resolution of 1.25 into the dialog box. Click OK. 

• The eluent conditions should change to 7.04 mM, 90.0 % with a minimum 

resolution criterion of 1.251. The time axis of the Virtual Chromatogram 

should be about 34 minutes. 

• Left click on the ‘Criterion’ menu, then left click on ‘Find Global Optimum’. 

• Virtual Column 2 will return to the global optimum with the time axis of the 

Virtual Chromatogram about 65 minutes. 

If you enter a minimum acceptable resolution greater than the global optimum, Virtual 

Column 2 will tell you that it couldn’t find a chromatogram to match that criterion. 

• Left click on the Criterion menu and select “Find Fastest Chromatogram…”. 

• Enter 1.5 into the Fastest Chromatogram Finder dialog box. Virtual Column 2 

should inform you that there are no chromatograms that match that criterion. 

Changing the Resolution Criterion 

• Left click on the ‘Criterion’ menu. There should be a tick next to ‘Minimum 

Resolution’, as in Figure 8. Left click on ‘Normalised Resolution Product’. 

After completing the calculations, the Resolution Response Surface contour 

plot should change to a new response surface. The optimum eluent conditions 

should now be 7.84 mM, 73.6 % with a resolution criterion of 0.473. 

• Left click on the ‘Criterion’ menu, then click on ‘Minimum Resolution’ to 

change the resolution criterion back. 

For difficult separations the minimum resolution criterion is helpful, as it will try to 

maximise the resolution of any difficult to separate peak pairs. For easy separations 

the normalised resolution criterion is helpful as it will try to maximise the resolution 

of all peak pairs. 
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Turning Asymmetric peaks on and off 

When ‘Asymmetric Peaks’ is turned on, the resolution is calculated based on the 

Exponentially Modified Gaussian peak separation. Thus the asymmetry values can 

impact the overall resolution significantly. Turning asymmetric peaks on and off 

should produce an easily identifiable change in the resolution response surface. 

• Left click on the ‘Asymmetric Peaks’ check box. The tick in the box should 

disappear and the response surface should redraw itself, this time based on 

symmetrical (Gaussian) peaks. The optimum eluent conditions should now be 

5.76 mM, 50.4 % with a resolution criterion of 1.965. 

• Left click on the ‘Asymmetric Peaks’ check box to restore the asymmetry 

(Exponentially Modified Gaussian) calculations. 

Viewing the Resolution Response Surface in true 3D 

• Left click on the ‘View’ menu (Figure 10) and click on ‘3D Plot’. After 

completing some calculations the contour plot should disappear and be 

replaced with a wire frame 3D plot over a contour plot. Two extra scroll bars 

should appear inside the existing scroll bars (Figure 11). 

 

Figure 10. View menu. 

 

Figure 11. 3D Resolution Response Surface showing inner scroll bars. 

inner scroll bars 
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• Use the horizontal inner scroll bar to rotate the wire frame around the z axis, 

and the vertical inner scroll bar to rotate the wire frame around the x axis. 

• Right click on the 3D plot to activate the 3D plot context sensitive menu 

(Figure 1). 3D plotting controls are accessed through this menu. 

 

Figure 12. Response Surface context sensitive menu. 

• Left click on the ‘View’ menu and click on ‘Contour Plot’ to return to the 

default contour map. 

Clicking on the 3D image of the response surface will not change the eluent 

conditions. Only the contour plot can be used in this way. 

Viewing the Retention Times of the analytes 

• Left click on the ‘View’ menu (Figure 10) and click on ‘Retention Times’. A 

‘Virtual Column 2 Retention Time Results’ table should be displayed (Figure 

13). 
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Figure 13. Virtual Column 2 Retention Time Results Table. 

• Left click on the Print button to print a copy of the retention times. 

• Left click on the Close button to close the window. 

The column on the right gives the resolution between the analyte in that row and the 

next. For example in Figure 13, the resolution between Fluoride and Chloride is 

5.478. 

Calculating the Eluent Composition 

The Eluent Composition Calculator is a useful tool for making your own eluents 

manually. It is also possible to use a gradient or multi-valve pump to mix together 

carbonate and bicarbonate eluents in the correct ratio. 

• Left click on the ‘View’ menu (Figure 10) and click on ‘Eluent Composition’. 

A ‘Virtual Column 2 Eluent Composition’ window should appear (Figure 14). 
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Figure 14. Virtual Column 2 Eluent Composition selection window. 

• Left click on ‘Sodium Hydrogen Carbonate’ radio button in the ‘Select a 

Monovalent Eluent Species’ group box, and ‘Sodium Carbonate Monohydrate’ 

radio button in the ‘Select a Divalent Eluent Species’ group box. 

 

Figure 15. Virtual Column 2 Eluent Composition results window. 
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• Left click on the Next button to advance to the results page (Figure 15). A 

description of how to make up the eluent from Sodium Hydrogen Carbonate 

and Sodium Carbonate Monohydrate should be displayed. 

• Left click on the Print button to print the description. 

• Left click on the Close button to close the window. 

Printing the Response Surface and Virtual Chromatogram 

• Left click on the ‘File’ menu (Figure 16) and click on ‘Print’ to print both the 

response surface and the virtual chromatogram. 

 

Figure 16. File menu. 

• To print only the response surface, right click on the response surface to bring 

up the context sensitive menu (Figure 12) and click on ‘Export Dialog’ on the 

menu to open the Exporting Resolution Response Surface window (Figure 

17). 

 

Figure 17. Exporting Resolution Response Surface window. 
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• In the ‘Export Destination’ box select ‘Printer’ by left clicking on the Printer 

radio button. 

• Left click on the Print button. 

On some systems the response surface does not print from the File / Print command. 

The Export Dialog method is a work around for this problem. 

Restarting Virtual Column 2 

• Left click on the ‘File’ menu (Figure 16) and click on ‘New’. The Virtual 

Column 2 wizard should open. 

• Left click once on “Carbonate : Bicarbonate on a Dionex AS14A 3mm 

column” so that the selection is highlighted. 

• Left click once on the next button. The Wizard should advance to Step 2. 

• Left click once on the Load Selection button. This should open the Open 

dialog box. Left click once on the file name that you chose to save your 

selection file as to highlight it. It should have a .vcx suffix. 

• Left click once on the “Open” button. The Wizard should now be at step five 

with a void time value 1.25. 

• Left click once on the “Finish” button. This should close the wizard and the 

Virtual Column 2 main window should become active. 

Once the File / New command has been issued, all data in memory is erased. Pressing 

Cancel on the Virtual Column 2 Wizard will return you to a blank main window. 

Closing Virtual Column 2 

• Left click on the ‘File’ menu (Figure 16) and click on ‘Exit’. 
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Chapter 4 

Learning Virtual Column 2. Tutorial 3 – The Main 
Window (single species eluents) 

4.1. Introduction 

In order to run, Virtual Column 2 requires detailed information about the system it is 

trying to model. The Virtual Column 2 Wizard is the part of the application designed 

to gather this information in as simple a manner as possible. This chapter will start 

with a brief guide to the Wizard, which will open a single species eluent database. 

Familiarity with the Wizard from Chapter 2 is assumed. 

4.2. The Wizard 

• Start the application by clicking on the shortcut in the Start Menu, Programs, 

Virtual Column 2 menu. 

• Left click once on ‘Hydroxide on a Dionex AS11 column’ (Figure 18). 

 

Figure 18. Virtual Column 2 Wizard Step One. 

• Left click once on the Next button. 
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• Tick the following check boxes to select a series of analytes – Void Dip, 

Fluoride, Methanesulfonate, Chloride, Nitrite, Bromide, Chlorate, Iodide, 

Sulfate, Oxalate, Phthalate, Chromate, Thiosulfate and Phosphate (Figure 19). 

 

Figure 19. Virtual Column 2 Wizard Step Two. 

• Left click once on the Next button. 

 

Figure 20. Virtual Column 2 Wizard Step Three. 
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• Change the Void Dip peak area to 0.25 (Figure 20). 

• Left click twice on the Next button to advance to Step 5. 

• Left click the Finish button to complete the Wizard. 

This procedure will open a Hydroxide database, which is a single species eluent 

database. Virtual Column 2 will automatically detect this and switch to single species 

eluent mode. This results in the resolution response surface being a line graph rather 

than a contour plot. 

4.3. Getting Started 

After completing the Wizard, the Virtual Column 2 main form should look something 

like Figure 21. 

 

Figure 21. Virtual Column 2 main window for single species eluents. 

The parts and functions of the windows are the same as for dual species eluents 

(Figure 6) with the exception that there is no vertical scroll bar. 
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4.4. Using Virtual Column 2 

The Virtual Column 2 main window is split into two sections, the Resolution 

Response Surface and the Virtual Chromatogram. The Resolution Response Surface is 

a line graph of the resolution criterion over the entire search area. 

The Virtual Chromatogram is a representation of the chromatogram that would be 

expected with the currently selected eluent conditions. The horizontal scroll bar can 

be used to select any eluent condition within the search area. The program starts by 

locating the global maximum and setting the initial eluent conditions to that value. 

In this tutorial, only functions that differ with the dual species eluent systems will be 

covered. Functions that are equivalent in both modes have been covered in the 

previous chapter. 

Changing the eluent concentration 

• Position the cursor over the right arrow of the horizontal scroll bar. Press and 

hold the left mouse button. The eluent concentration should increment. Hold 

the left mouse button down until the eluent concentration is 10.032 mM, and 

then release the mouse button. 

• Single click the left or right arrows of the horizontal scroll bar to move one 

increment at a time. 

• The minimum resolution criterion should be 0.372. 

• Position the cursor over the horizontal scroll bar between the left arrow and 

the scroll indicator. Press the left mouse button once. The eluent concentration 

should decrement a larger value than with the left arrow. The eluent 

concentration should be 7.806 mM. 

• Position the cursor over the scroll indicator of the horizontal scroll bar. Press 

and hold the left mouse button. Move the cursor in a straight line to the left or 

right. The eluent concentration should decrease or increase as the scroll 

indicator moves. When the eluent concentration reaches a desired value 

release the left mouse button. 

The eluent concentration can also be modified by left clicking directly on the 

resolution response surface. 
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• Position the cursor over the red line of the resolution response surface line 

graph at the peak about 9.5 mM. The cursor should change to a cross hair. Left 

click once while the cursor is a crosshair. 

Other differences from dual species eluent mode 

• There is no 3D plotting capability for the line graph. 

• There is only one class of eluent species available for eluent composition 

calculations, thus the Virtual Column 2 eluent composition window contains 

only one group box (Figure 22). 

 

Figure 22. Virtual Column 2 Eluent Composition window for single species eluents. 

• The line graph cannot be printed individually. 
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Chapter 5 

Glossary 

Terms in bold have their own entries. 

3D Plot: A true three dimensionally rendered representation of a surface. 

Analyte. 

Asymmetry value. 

Auto-Scale: A feature used to ensure that a virtual chromatogram stretches across the 

entire width of the x-axis. 

Check box: A check box consists of a square box and text label that indicates a choice 

the user can make by selecting the box. Any number of the options in the set can 

be selected at a time. 

Column (stationary phase). 

Column database file: A file saved to the hard drive with a .vcl extension that 

contains retention data collected using a correct experimental design. Virtual 

Column 2 uses these databases to solve its internal retention models so that 

retention data can be predicted. 

Database file: see Column database file. 

Dialog box: A window displayed in the user interface to solicit input from the user 

and/or to display output to the user. 

Drop-down list box: A list box that displays a current setting, but can be opened to 

display a list of choices. 

Dual Species Eluent. 

Eluent (mobile phase). 

Eluent composition. 

Embedded. 

Empirical End Points Model. 
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Experimental design. 

Global optimum. 

Group box: A rectangle that surrounds a set of controls, such as check boxes or radio 

buttons, and contains a label. The sole purpose of a group box is to organize 

controls related by a common purpose (usually indicated by the label). 

Linear Solvent Strength Model. 

Local optimum. 

Maximise: To display a window at its largest size. 

Minimise: To minimise the size or appearance of a window; in some cases this means 

to hide the window. 

Minimum resolution criterion. 

Normalised resolution product criterion. 

Optimisation. 

Peak area. 

Peak pair. 

Radio button: Radio buttons are used to select one of several options. A radio button 

contains a small circle with text next to it, when selected; the circle has a smaller, 

filled circle inside it. Selecting one button in a set deselects the previously selected 

button, so only one of the options in the set can be selected at a time. 

Resolution. 

Resolution criterion. 

Response surface. 

Restore: To return a window to its pre-minimised or pre-maximised size and 

position. 

Retention factor. 

Retention modelling. 

Retention time. 

Search area. 
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Selection File: A file saved to the hard drive with a .vcx extension that contains data 

normally gathered during the Virtual Column 2 Wizard. 

Simulation. 

Single Species Eluent. 

Theoretical Plates. 

Unzoom: Decreases the magnification of a part of a window to restore it to its original 

size. 

Virtual chromatogram: A chromatogram drawn by Virtual Column 2 based on 

predicted retention times and embedded peak areas and asymmetry values. 

Virtual Column 2 main window: The main working part of Virtual Column 2 where 

the resolution response surface and virtual chromatogram is drawn. 

Virtual Column 2 Wizard: A set of simple steps in a window designed to gather 

detailed information about the system Virtual Column 2 is trying to model. 

Void Dip. 

Void Time (Void Volume). 

Wizard Selection File: See Selection File. 

Zoom: Increases the magnification of a part of a window to aid in visualisation.
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Appendix A 

Retention Models and Resolution Algorithms 

Virtual Column 2 includes 2 built in models, one for single species eluents and the 

other for dual species eluents. Both models are based on the Linear Solvent Strength 

model1. 

The single species eluent model is called the Empirical End Points approach to the 

Linear Solvent Strength Model2 and is defined by the following equation, (1): 

1 2log ' log Tk C C E= +  (1) 

where k’ is the retention factor, C1 and C2 are constants for a given analyte and 

column, and ET is the eluent concentration of the eluting species. 

Embedded data, which have been acquired according to a correct experimental design, 

are used to solve the two constants, C1 and C2. For each analyte three retention times 

have been measured at known eluent concentrations, two at the end-points of the 

search area, and one extra point near the centre of the search area. Values for C1 and 

C2 are solved for each consecutive pair, giving two equations, one applicable to one 

half of the search area, and the other to the remaining half of the search area3. 

The dual species eluent model expands on the Empirical End Points approach to the 

Linear Solvent Strength Model, allowing prediction for both total eluent concentration 

and the ratio between two eluting species. The interface for Virtual Column 2 uses 

total eluent concentration and eluent ratio (R), however the dual species eluent model 

uses total eluent concentration and the concentration of doubly charged eluent species 

([E2-]) as parameters. The concentration of doubly charged eluent species can be 

calculated from total eluent concentration and eluent ratio using the following 

equation, (2): 

2 .E
100

TE R−  =   (2) 

Embedded data for dual species eluent systems has once again been acquired using a 

correct experimental design. For each analyte nine retention times have been 

measured at known eluent compositions according to Figure 23. 
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Figure 23. Correct Experimental Design for Dual Eluent Species
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erimental design can be thought of as consisting of four quadrants, where 

drant is defined by the four retention times at the end points. The dual species 

odel is solved separately for each individual quadrant. 

l species eluent model comprises three set equations. The first two are given 

tions (3) and (4): 

11 21 log TC C E+  (for low R). (3) 

12 22 log TC C E+  (for high R). (4) 

uations are identical to the single species eluent equations and, once solved, 

sed to calculate retention times on the top or bottom horizontal lines of the 

rea. 

d equation is given in equation (5): 

2-
1 2 log ED D  +    (5) 

late a retention factor for a given ET and [E2-], equations (3) and (4) must be 

or each quadrant initially. Once these equations have been solved, retention 

an be calculated for a given ET value at both low and high values of R using 

s 3 and 4 respectively. These two retention factors are then used to solve for 

2 in equation (5). Once D1 and D2 are known for a given ET value, retention 

or any value of R can be calculated for that ET value using equation (5). D1 

ust be solved separately for each value of ET . 
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Virtual Column 2 calculates retention times for all selected analytes across the entire 

search area. If a single species eluent is used then 1000 retention times per analyte are 

calculated. If a dual species eluent is used then a grid of 100 x 100 retention times per 

analyte are calculated. From this data Virtual Column 2 constructs a ‘virtual 

chromatogram’ for any ET and value of R the user chooses. 

Virtual Column 2 ranks these virtual chromatograms by assigning them a value based 

on one of two resolution criteria, Minimum Resolution or Normalised Resolution 

Product1. For each peak pair a resolution value is calculated using equation (6): 

1 '
1 1 ' 2s

k NR
k

α
α

−  =   + +  
 (6) 

where α is the separation factor given by the ratio of retention factors for the peak 

pair, k’ is the average retention factor for the peak pair and N is the number of 

theoretical plates. 

For the minimum resolution criterion the chromatogram is assigned the minimum 

resolution of all the adjacent peak pairs in the chromatogram. The minimum 

resolution criterion gives a value of zero to a chromatogram that has one or more peak 

pairs co-eluting. A value of 1.5 is generally regarded as baseline separation, although 

a value of 1.2 is often considered acceptable resolution for most applications. 

The normalised resolution product (r) is defined by equation (7): 
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where n is the number of peaks and RS i,i+1 is the resolution between peaks i and i+1. 

The normalised resolution product criterion gives a value of zero to a chromatogram 

that has one or more peak pairs co-eluting, and a value of one for a chromatogram that 

has evenly spaced peaks. 

 

                                                 

1 P.R. Haddad and P.E. Jackson, Ion Chromatography: Principles and Applications, Elsevier, 

Amsterdam, 1990. 
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2 Critical Comparison of Retention Models for Optimisation of the Separation of Anions in Ion 

Chromatography. 1. Non-Suppressed Anion Chromatography. John E. Madden and Paul R. Haddad. J. 

Chromatogr. A, 829 (1999) 65 - 80. 

3 J.E. Madden, G.W. Dicinoski, M.J. Shaw and P.R. Haddad, Unpublished Data. 
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